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About this document

This document contains information describing the SuperNode Data Manager
(SDM) Enhanced Terminal Access (ETA) application, including procedures
for installing the application. It is intended for system administrators and
maintenance personnel.

Organization of this document
The following table describes the organization of this document.

Checking the version and issue of this document
The version and issue of the document are indicated by numbers, for example,
01.01.

The first two digits indicate the version. The version number increases each
time the document is updated to support a new software release. For example,

Chapter Title Description

1 Understanding ETA Describes the purpose of the ETA application
and its architecture.

2 ETA server software installation
and configuration

Describes ETA server software installation and
configuration procedures.

3 ETA client software installation and
configuration

Describes ETA
client software installation and configuration
procedures.

4 ETA graphical user interface (GUI) Describes the ETA GUI menus and options,
and how to use the on-line help utility.

5 Using ETA Describes how to use ETA to establish an
SDM or CI/MAP session, to log a session to a
file, to save a current RMI or MAP view, and to
change CM passwords.

6 Appendix: ETA status and error
messages

Lists and describes the ETA status and error
messages,and what actions you must take to
resolve problems.
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the first release of a document is 01.01. In thenextsoftware release cycle, the
first release of the same document is 02.01.

The second two digits indicate the issue. The issue number increases each time
a document is revised but re-released in thesame software release cycle. For
example, the second release of a document in the same software release cycle
would be 01.02.

To determine which version and issue of this document applies to the software
in your office, check the release information inDMS-100 Family Guide to
Northern Telecom Publications, 297-1001-001.

References in this document
The following documents are referred to in this document:

• SuperNode Data Manager Fault-tolerant User Guide,297-5061-906

• OSF ISBN 0–13–1858440,Release 1.1 (1995), Open Software
Foundation, Inc., 11 Cambridge Center, Cambridge, MA 02142

Writing conventions
This section describes the writing conventions used in this document.

Input prompt
An input prompt (> or #) indicates that the information that follows is a
command:

>LIST

Commands and fixed parameters
Commands and fixed parameters that are entered at a MAP terminal are shown
in uppercase letters:

>LIST ALL

UNIX commands and fixed parameters that are entered at the SDM are shown
in lowercase and uppercase letters, depending on the UNIX syntax:

>echo $TERM

Variables
Variables that are entered at a MAP terminal are shown in lowercase letters:

>TABLE table_name

UNIX variables that are entered at the SDM are shown in italicized lowercase
letters:
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>setenv TERM term_type

The letters or numbers that the variable represents must be entered. Each
variable is explained in a list that follows the command string.

Responses
Responses are shown in a different typeface:

SDM 0 ManB
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1  Understanding ETA

Overview
The ETA application provides secure remote access to the DMS SuperNode
Data Manager (SDM) across the operating company’s transmission control
protocol/Internet protocol (TCP/IP) wide area network (WAN). From a
graphic user interface (GUI) running on a remote client workstation, ETA
provides multiple access to the following:

• SDM programs that have a command-line interface, such as the SDM
Remote Maintenance Interface (RMI)

• SDM UNIX shells

• the computing module (CM) command interpreter (CI)

• maintenance and administration position (MAP) terminal sessions

ETA uses the SDM remote GUI framework to communicate between the GUI
client and the SDM in a secure environment. During a telnet session, userIDs
and passwords are passed freely across the network. ETA uses Distributed
Computing Environment (DCE) security servers to validate users. The system
only gives access to valid users, based on the limitations that are configured in
each user’s profile. The authentication process ensures a secure operating
environment.

The main features of the ETA application are as follows:

• only a single login

• userID and passwords entered once per shift when the workstation session
starts

• userIDs and passwords that correspond to a DCE security account

• automatic login from the client workstation to the CI/MAP terminal
sessions, when required

• automatic login from the client workstation to the SDM, when required

• userIDs and passwords encrypted
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How the ETA application relates to the SDM
The SDM is the Nortel Networks operations, administration, and maintenance
(OA&M) processing complex for the DMS SuperNode switch. The SDM is a
high-performance UNIX computing platform and software applications
environment that allows operating companies to operate, administer, maintain,
and provision DMS SuperNode switch components and services. The SDM
supports the ETA application, which provides remote and secure access to the
SDM and the CM using DCE security servers. ETA consists of a client
program running on a remote machine, and a server running on the SDM.

Note: Refer to theSuperNode Data Manager Fault-tolerant User Guide,
for more information about the DCE.

DCE login
The DCE login process consists of two components — the DCE principal
(userID) and password. Both are entered once daily or for each work session.
The method and frequency for logging on to the DCE depends on how the
client workstation is configured. It can be configured in one of three ways:

1. If integrated DCE login is being used, then the DCE login session occurs
when you log in to UNIX at the beginning of the day.

2. If integrated DCE login is not being used, but a DCE login command is
included in the user’s login profile, DCE authentication occurs once per
shift.

3. If the client workstation does not use DCE login, and the ETA tool is
started without logging in to DCE, the ETA client displays a dialog box
that asks for the user’s DCE principal name and password each time the
ETA client is started.

Note: Login information may expire after a few hours depending on how
the DCE security server is configured. Refresh your login by entering your
password. If you are using the ETA client, you are prompted for the
password.

After you have logged in to DCE, you may start one or more SDM sessions,
and one or more CI/MAP sessions depending on the configuration of the your
profile.

Enhanced Terminal Access architecture
The ETA application consists of three components — the ETA client, the ETA
server, and the client user profiles that are stored in the DCE security server.
ETA provides a remote client program that provides windows where
character-mode commands are invoked for the SDM on the network. The ETA
client runs on a UNIX workstation that interconnects securely with an ETA
server on the SDM where the command is either executed or passed on to the
CM for execution.
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ETA client
The ETA client runs on a remote workstation. Together, with the ETA server
on the SDM, the ETA client provides secure terminal access to the SDM and
the CI/MAP terminal sessions. The ETA client operates with SDMN0008,
SDMN0009, and SDMN0010 servers. The input and output data is displayed
in a dialog box.

The following UNIX platforms support the ETA client:

• Hewlett-Packard 700/800 series workstations running the HP-UX 10.20
operating system (or higher) with year 2000 enhancements

• SUN SPARC workstations running the Solaris 2.4 operating system (or
higher) with year 2000 enhancements

• SUN SPARC workstations running the year 2000 compliant Solaris 2.6
operating system (or higher)

ETA server
Each SDM has one ETA server. The ETA server is used for terminal sessions
from the remote ETA clients. The ETA server supports up to 64 SDM sessions.
It does not restrict the number of CI/MAP sessions. In practice, however,
approximately 50 CI/MAP sessions are available. The actual number depends
on the number of TCP sessions that are used by other services on the DMS
switch. The number of TCP sessions permitted is configured in Table IPHOST.

DCE security server
The DCE security server contains a database or registry that stores account
information on all ETA client users. The DCE security server informs the ETA
server of the SDM userID (root or maint) of a user, and their CM userIDs and
passwords.

SDM session
The first step in establishing an SDM session is to log in to DCE. When you
log in to DCE, your DCE principal name and password are sent from the ETA
client to the DCE security server for authentication. The ETA client then
obtains a list of available SDMs from the DCE cell directory server. This list
is displayed in the Enhanced Terminal Access window.

After you select Access SDM, the ETA client uses remote procedure call
(RPC) to send a request to the ETA server to ask for secure access to the SDM.
The ETA client sends its IP address and port number to the ETA server, and
information on the ETA client, including its principal name. A TCP/IP
connection is then established between the ETA client and server.

The ETA server obtains your SDM userID from the DCE security server. The
SDM userID is either root or maintenance (maint). The ETA server then
obtains your SDM userID profile from the SDM file, /etc/passwd. The profile
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information includes the root or maint password, the group ID, and the
preferred shell. Depending on your profile, you will either see a UNIX shell or
an SDM program, such as Remote Maintenance Interface (RMI). Before the
SDM program starts, the ETA server sets your home directory, and your DCE
authentication environment.

Figure 1-1 Steps in an SDM session

CI/MAP session
The first step in establishing a CI/MAP session is to log into the DCE. When
you log into the DCE, your DCE principal name and password are sent from
the ETA client to the DCE security server for authentication. The ETA client
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then gets a list of available SDMs from the DCE cell directory server. This list
is displayed in the Enhanced Terminal Access window.

After you select Access CI/MAP, the ETA client uses remote procedure call
(RPC) to send a request to the ETA server asking for secure access to a
CI/MAP terminal sessions. The ETA client sends its IP address and port
number to the ETA server, and information on the ETA client, including its
principal name. A TCP/IP connection is then established between the ETA
client and server.

The ETA server obtains one or more CM userIDs and passwords from the DCE
security server. The ETA server then starts a telnet client session between the
SDM and the CM. There can only be one session for each CM userID and
password. The ETA server sends an error message to the ETA client if all CM
userIDs and passwords are in use.
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Figure 1-2 Steps in a CI/MAP session
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2  ETA server software installation and
configuration

This chapter describes ETA server software installation and configuration
procedures for the SuperNode Data Manager (SDM).

You must have root user privileges to perform the installation procedures in
this chapter.

The SDM software packages contain both the ETA server and client software.
The Software Inventory Manager (SWIM) feature allows you to install one or
more application software packages on the SDM during one procedure.

You must complete the installation and configuration procedures in the order
outlined in this chapter. This chapter discusses the following topics:

• Limitations and restrictions

• Prerequisites

• Compiling a list of server software filesets

• Installing the server application software on the SDM server using SWIM

• Configuring the server application software using SWIM

• Starting the ETA server on the SDM

• Removing an ETA server

ATTENTION
Nortel Networks recommends using the batch installation steps when
instructed, to reduce the amount of time required to install SDM
applications.
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Limitations and restrictions
The following limitations and restrictions apply to ETA:

• The SDM for the remote client workstation must be configured in the
Distributed Computing Environment (DCE) cell before installing ETA
software. For information on DCE, refer to theDMS-100 Family
SuperNode Data Manager Fault-tolerant User Guide, 297-5061-906.

To access an SDM running the SDMN0008 software release of ETA, all
SDMN0008 and SDMN0009 defined DCE principal names must be updated.
Use the software in SDMN009.3 release or later. For information on updating
DCE principal names, see theDMS-100 Family SuperNode Data Manager
Fault-tolerant User Guide, 297-5061-906.

Prerequisites
The following are prerequisites for installing the server software:

• installation of the SDM platform maintenance software

• root and maintenance (maint) access to the SDM

• cell_admin or sdm_admin privileges for the DCE cell

• DCE account with administrative privileges

Both sdm_admin and cell_admin DCE account have the required privileges to
make changes to the DCE cell. However, the sdm_admin account functions as
a sub-administrator account with limited privileges. The purpose of an
sdm_admin account is to perform administrative tasks that are related to the
SDM within the DCE cell.

The sub-administrator account requires the following privileges:

• the ability to create accounts

• the ability to add permission for the SDM server organization

• the ability to add permission for the sdm-servers-using-cds group

• the ability to insert and modify the permissions for the access control list
(ACL) on the /.:/subsys/NT/SDMCDS directory.

ATTENTION
If the sdm_admin account you are using to perform this procedure does
not exist, you can use the cell_admin account instead. You also can exit
the procedure, and proceed to the “DCE Creating a DCE user”
procedure to create an sdm_admin account. Return to this procedure
after you have created an sdm_admin account.
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Compiling a list of server software filesets

Instructions for batch installation of SDM application software
You must compile a list of software filesets for each application you wish to
install or upgrade. Before beginning the installation procedures, refer to the
user guide of each application for a list of filesets.

ETA fileset descriptions
Before you begin the installation procedure of ETA, you must record the
names of the server filesets. You must refer to this information during the
installation procedures in this chapter.

ETA application fileset name
Record the application fileset name. The system displays the Enhanced
Terminal Application fileset in one of the following forms, depending on the
filter view you use:

• SDM_ETA.eta (name view)

• Enhanced Terminal Access (description view)

Note 1: The filter view command on the SWIM main menu allows you to
change the way the system displays the filesets. Use the filter view to toggle
between the fileset name view and the fileset description view.

Note 2: If you wish to install other applications at this time, refer to the
fileset descriptions in the respective user guides.

Once you have recorded the fileset information, you can refer to the user guide
of your other SDM applications for fileset information. If you have completed
the list of filesets for all of the applications you wish to install, proceed to the
procedure,“Installing the server application software on the SDM server using
SWIM” on page 3 in this chapter.

Installing the server application software on the SDM server using
SWIM

The following section describes how to install the SDM server software
application using SWIM.

ATTENTION
Nortel Networks recommends using the batch installation steps in this
section to reduce the amount of time required to install SDM
applications.
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SDM server software package
Use the following procedure to install a software install image from a digital
audio tape (DAT). This procedure applies to an initial installation of the SDM
server software only.

You must have root user access to the SDM to perform this procedure.

Installing the server software using SWIM
The SWIM package is part of the SDMPL010 base software release. SWIM
provides the user interface (UI) for local SDM software installation and
maintenance. You can access SWIM from the SDM maintenance interface. For
more information on SWIM, refer to theDMS-100 Family SuperNode Data
Manager Fault-tolerant User Guide.

The following flowchart summarizes the installation procedures for the
application software.

ATTENTION
Verify the SDM is configured in the DCE cell before performing this
procedure. Refer to theDMS-100 Family SuperNode Data Manager
Fault-tolerant User Guide,297-5061-906 for a detailed procedure to
configure an SDM in a DCE cell.

ATTENTION
Before you can perform an installation using SWIM, you must have the
SDM base software installed on the SDM.

ATTENTION
Nortel Networks recommends that you use the batch installation steps in
this section to reduce the amount of time required to install SDM
applications.
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Figure 2-1 Installing the server application software on the SDM using SWIM
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Procedure 2-1 Installing the application software on the SDM using SWIM

At the local or remote VT100 console

1 Log into the SDM as root user.

2 Determine whether you are installing the software image using the tape, or
the disk.

At the SDM

3 Insert the tape containing the SDM application packages into the SDM tape
drive. Figure 2.2 shows how to set the tape into the DAT drive in domain 0
(slot 2).

Figure 2-2 Inserting the tape into the DAT drive in domain 0 (slot 2)

If Do

you are using the tape step 3

you are using the disk step 5
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At the local or remote VT100 console

4 Access the SDM maintenance interface and select the tape source by typing

#sdmmtc apply n

and pressing the Enter key.

where

n
is the domain where you have inserted the tape.

5 Access the SDM maintenance interface, and select the source by typing

#sdmmtc apply directory

and pressing the Enter key.

where

directory
is the name of the directory for the disk.

6 The system displays a list of filesets that are available on the tape drive. Each
fileset has an identification number shown in the column under the number
symbol.

Example response of the Source menu level:

Source Device: Tape drive on the main chassis slot 2
# Fileset Description    Current Available
1 Client Common Resources   12.0.12.0 12.0.12.0 i
2 Log Delivery Service   12.0.12.0  12.0.12.0 i
3 Platform Maintenance     12.0.12.0  12.0.12.0 i
4 OM Access Service     12.0.12.0 12.0.12.0 i
5 Table Access Service   12.0.12.0  12.0.12.0 i
6 Enhanced Terminal Access      NA  12.0.12.0 i
7 Installationg & Upgrade Tools 12.0.12.0  12.0.12.0 i
8 Installation & Upgrade Lists 12.0.12.0  12.0.12.0 i
9 Secure File Transfer NA 12.0.12.0 i
10 Exception Reporting NA 12.0.12.0 i

Note 1: You can use the Up and Down commands to view additional
filesets if the list extends beyond one screen. You can also use the Filter
command to shorten the list.

Note 2: When shown in the fileset list, install fileset images appear with a
letter i to distinguish them from corrective content images. If you apply the
install image, the system removes all archived versions of that fileset from
the SDM hard disk. For more information on the Apply command menu,
refer to the SuperNode Data Manager Fault-tolerant User Guide.

If Do

you inserted the tape into the tape
drive in slot 2 (domain 0)

sdmmtc apply 0, and proceed to
step 6.

you inserted the tape into the tape
drive in slot 13 (domain 1)

sdmmtc apply 1, and proceed to
step 6.
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7 Select the ETA application fileset that you wish to install. If necessary, refer to
the list of filesets that you recorded in the previous section titled “Compiling a
list of server software filesets”. To select the application fileset, type

>select n

and pressing the Enter key.

where

n
is the identification number listed next to the ETA fileset shown in the
column under the number symbol (#) in the SWIM Apply level.

In the example response shown in step 6, the identification number for
Enhanced Terminal Access is 6, Secure File Transfer is 9, and Exception
Reporting is10.

After you have selected a fileset, the system highlights the entire fileset on the
terminal. The system displays the total number of selected filesets on the top
right corner of the SDM maintenance interface.

8

Repeat step 7 for any other application filesets that you wish to install. When
you have selected the filesets you wish to install, go to the next step.

9 Apply the selected software fileset(s) by typing

>apply

and pressing the Enter key.

Note: The system checks for warnings or errors before it exercises the
apply command. If you have selected any filesets whose matching filesets
require installation, the system generates a warning message.  The
warning message indicates that the SDM will apply the matching filesets
even though you have not selected them.

10 Exit the SDM maintenance interface by typing

>quit all

and pressing the Enter key.

11 You have completed this procedure..

Verifythe SDM has configured the software for each application you installed.
If the SDM did not configure the software for the application, you must
configure the software manually. Refer to the procedure “Configuring the
server application software using SWIM”.

Configuring the server application software using SWIM
The following section describes how to configure the server application
software using SWIM.

ATTENTION
Nortel Networks recommends using the batch installation steps in this section
to reduce the amount of time required to install SDM applications.
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Configuring the application software using SWIM
The SWIM package is part of the SDMN0010 base software release. SWIM
provides the UI for local SDM software installation and maintenance. You can
access SWIM from the RMI. For more information on SWIM, see the
SuperNode Data Manager Fault-tolerant User Guide, 297-5061-906.

Preparing the DCE for the application software
You must have a DCE account with administrative privileges to add
application servers, such as ETA, Exception Reporting, and Secure File
Transfer.

Both the sdm_admin and cell_admin accounts have the required privileges to
make changes ot the DCE cell. However, the sdm_admin account functions as
a subadministrator account with limited privileges. The sdm_admin account
performs administrative tasks that are related to the SDM within the DCE cell.

ATTENTION
Before you can perform an installation using SWIM, you must have the
SDM base software installed on the SDM.

ATTENTION
If you use the sdm_admin account to perform this procedure, and the
sdm_admin account does not exist, you can use the cell_admin account
instead. You also can exit the procedure, and proceed to the “Creating a
DCE user” procedure to create an sdm_admin account. Return to this
procedure after you have created an sdm_admin account.

CAUTION
Risk of revealing the administrative user password
If you use telnet to access the SDM remotely, and use the
default cell_admin “master administrator” account to add
the application server, the system sends the password of
the administrative user in clear text across the network. To
prevent this potential security risk, Nortel Networks
recommends that you execute the command from a
terminal attached to the SDM console port.
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The DCE administrator account can create a sub-administrator account with
privileges to add only SDM servers. The sub-administrator account requires
the following privileges:

• ability to create principals

• add permission for the SDM server organization

• add permission for the sdm-servers-using-cds group

• insert and modify access control list (ACL) permissions on the
/.:/subsys/NT/SDM CDS directory

The following flowchart summarizes the installation procedures for the
application software. To complete the procedure for configuring the
application software, perform the step-action procedures that follow the
flowchart.
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Figure 2-3 Summary of Configuring the server application software using SWIM
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Procedure 2-2 Configuring the server application software using SWIM

At the SDM:

1 Log into the SDM as the root user.

2 Access the SDM maintenance interface by typing

#sdmmtc

and pressing the Enter key.

The system displays the top menu level of the RMI.

3 Select the Config option in the SWIM menu by typing

>config

and pressing the Enter key.

The system displays the Config menu that lists the filesets available for
installation.

Example response:

# Fileset Description Status
1 Enhanced Terminal Access Unconfigured
2 Secure File Transfer Secure and Normal FTP Access
3 Exception Reporting  Configured

4 Execute the unconfigured interactive configuration scripts by typing

>config n

and pressing the Enter key.

where

n
is the number of the fileset you want to configure.

5 If you have commissioned DCE, the following prompt appears:

Please enter the DCE administrator id: [sdm_admin]

6 Press the Enter key.

The system returns to the SDM maintenance interface screen.

Go to step 11.

7 The system prompts you to enter a DCE administrator name. To accept the
default DCE account (sdm_admin), press the Enter key, or enter another DCE
administrator account.

Example response:

Enter the password for the DCE administrator sdm_admin:

Note: You can also type another DCE account with administrative
privileges (cell_admin), as described at the beginning of this procedure.

If Do

DCE is not commissioned Step 6

DCE is commissioned Step 7
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8 At the “Password:” prompt, type

>password

and press the Enter key. The system configures the fileset and returns you to
the Config menu level.

where

password
is the password for the DCE administrator account name.

9 To exit from the SDM maintenance interface, type

>quit all

and press the Enter key.

10 To logout from the SDM, type

#exit

and press the Enter key.

11 You have completed this procedure.

Starting the ETA server on the SDM
The ETA client runs on any remote workstation that is configured in the DCE
environment. Along with the ETA server on the SDM, the ETA client provides
secure terminal access to the SDM and the MAP/CI terminal sessions. ETA
clients cannot access the ETA application until you start the ETA server.

Note: Before you begin this procedure, you must complete the installation
procedures described in “Installing the server application software on the
SDM using SWIM”.

The following flowchart summarizes the procedure for starting the ETA server
on the SDM. To complete the procedure for starting the ETA server on the
SDM, perform the step-action procedures that follow the flowchart.
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Figure 2-4 Summary of Starting the ETA server on the SDM
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Procedure 2-3 Starting the ETA server on the SDM

At the local or remote VT100 console

1 Log into the SDM as the maint user.

2 Access the RMI by typing

maint:sdmmtc

and pressing the Enter key.

The system displays the top menu level of the RMI.

3 Access the application (Appl) menu level by typing

>appl

and pressing the Enter key.

4 The application menu lists the software packages installed on the SDM.
Locate the Enhanced Terminal Access application. The version number is the
same as the one displayed when the software was installed.

Example of the application menu level

# Package Description  Version  State
1 Table Access Service  10.0.16.0  InSv
2 Operation Measurements 10.0.16.0  InSv
3 Log Delivery Service  10.0.16.0 InSv
4 Enhanced Terminal Access 10.0.16.0 OffL

5 If Enhanced Terminal Access is not InSv, as shown in step 4, then it must be
busied. Do this by typing

>BSY eta_application_id

and pressing the Enter key.

where

eta_application_id
is the number corresponding to the Enhanced Terminal Access
application.

6 Start the ETA application by typing

>RTS eta_application_id

and pressing the Enter key.

where

eta_application_id
is the number shown for the ETA application. The example shows how
the software packages are listed at the application menu level. To start
the ETA application, in this example, you would type RTS 4

Note: The state of Enhanced Terminal Access shown at the application
menu level of the RMI must be InSv. The Enhanced Terminal Access
application is dependent on the DCE service on the SDM. If DCE is not in
service, then Enhanced Terminal Access will be off-line.

7 You have completed this procedure.
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Removing an ETA server
Use this procedure to remove an ETA server. When the ETA application is not
required on the SDM, you must release the resources that were claimed by the
application server.

You can also use this procedure to clear problems with an application server.
It might be necessary to remove an ETA server from the DCE cell, then
recreate the server using the config command under the SWIM menu. For
information on server installation, refer to “Installing the server application
software on the SDM server using SWIM” of this chapter.

Problems with an application server include the following:

• the server identifies a mismatch resulting from a change to the switch
Common Language Location Identifier (CLLI)

• the server cannot authenticate itself because of keytab problems. This may
occur if the SDM data files are restored from a backup tape

• the server is unable to authenticate itself because its password has expired.
This may occur if the server is OffL or ManB for an extended period of
time.

To perform this procedure, you must have a DCE account with administrative
privileges and root user access to the SDM.

ATTENTION
You can use either the sdm_admin or the cell_admin account to perform
this procedure. If you use the default sdm_admin account to perform this
procedure, and the default account does no exist, you can use the
cell_admin account instead. You also can exit the procedure, and go to
the DCE Creating a DCE user procedure to create an sdm_admin
account. Return to this procedure after you have created an sdm_admin
account.

CAUTION
Risk of revealing the administrative user password
If you use telnet to access the SDM remotely, and use the
default sdm_admin or cell_admin account to execute the
DCE control program (dcecp) commands, the
administrative user password is sent in clear text across the
network. To prevent this potential security risk, Nortel
Networks recommends that you execute the commands
from a terminal attached to the SDM console port.
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Figure 2-5 Summary of Removing an ETA server
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Procedure 2-4 Removing an ETA server

At the local or remote VT100 console

1 Log into the SDM as the root user.

2 Log into DCE using the administrator userID by typing

#dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
 is the administrator userID.

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
 is the password for the administrator userID.

4 Invoke the DCE control program (dcecp) by typing

>dcecp

and pressing the Enter key.

5 List the key tables in the SDM by typing

dcecp>key catalog -simplename

and pressing the Enter key.

6 Determine whether the key table list contains a key table called eta.

7 List the principals that are supported by the key table by typing

dcecp>key list eta

and pressing the Enter key.

8 The list from the command executed in step 7 must contain entries that follow
the format: /.../cell name/sdm/clli/principal name.

where

cell name
is the cell in which the SDM reside.

clli
is the Common Language Location Identifier (CLLI) of the switch to
which the SDM is connected.

principal name
is the userID of the server.

If Do

the list contains the eta key table step 7

the list does not contain the eta step
key table 11

step 12
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9 Determine whether the principal name of all members in the list is the same,
and that it corresponds to the eta-server.

10 Remove the entries for the principal in the key table by typing

dcecp>key remove eta -member
/.../ cell_name /sdm/ clli /eta-server

and pressing the Enter key.

where

cell_name
is the cell in which the SDM resides

clli
 is the Common Language Location Identifier (CLLI) of the switch to
which the SDM is connected.

11 Delete the key table by typing

dcecp>key delete eta

and pressing the Enter key.

12 Remove the principal for the SDM application server by typing

dcecp>principal delete sdm/ clli /eta-server

and pressing the Enter key.

where

clli
 is the CLLI of the switch to which the SDM is connected.

13 Exit dcecp by typing

dcecp>exit

and pressing the Enter key.

14 Log out from DCE by typing

>exit

and pressing the Enter key.

15 You have completed this procedure.

If Do

all principal names are identical step 11

all principal names are not identical step 10
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3  ETA client software installation and
configuration

This chapter describes the ETA application client software installation and
configuration procedures.

The SuperNode Data Manager (SDM) software packages contain both the
server software and the client software. To install client software on the client
workstation, you must first install the client installer and launcher (CIL) tool.
This chapter provides the procedures to install CIL, and the ETA client
software.

This chapter describes the following topics:

• Limitations and restrictions

• Compiling a list of client software filesets

• Installing CIL on the client workstation

• Installing the client software on the client workstation

• Allowing ETA to operate across a firewall

ATTENTION
Nortel Networks recommends using the batch installation steps when
instructed, to reduce the amount of time required to install SDM
applications.



3-2   ETA client software installation and configuration

297-5051-904   Standard   06.01   August 1999

• Restricting the port ranges

• Managing ETA extended registry attributes (ERA). This section includes
how to do the following:

— create ERA schema types

— add ERA values for computing module (CM) userIDs and passwords

— add an ERA value for an SDM userID

— get ERA values for CM userIDs and passwords

— get the ERA value for the SDM userID

— remove ERA values for CM userIDs and passwords

— remove the ERA value for the SDM userID

Limitations and restrictions
The following limitations and restrictions apply to ETA:

• The following UNIX platforms support the ETA client:

— Hewlett-Packard 700/800 series workstations running the HP-UX
10.20 operating system, or higher, with year 2000 enhancements

— Sun SPARC workstations running the Solaris 2.4 operating system, or
higher, with year 2000 enhancements

— Sun SPARC workstations running the year 2000 compliant Solaris 2.6
operating system, or higher.

• The workstation must use Open System Foundation (OSF) Distributed
Computing Environment (DCE) version 1.1.

• The SDM for the remote client workstation must be configured in the DCE
cell before installing ETA software. For information on DCE, refer to the
SuperNode Data Manager Fault-tolerant User Guide 297-5061-906.

• To access an SDM running the SDMN0008 version of ETA, all
SDMN0008- and SDMN0009-defined DCE principal names must be
updated. Use the software in the SDMNM009.3 load or later. For
information on updating DCE principal names, see theSuperNode Data
Manager Fault-tolerant User Guide.

• NA007 CM software must be installed.

• The DISPLAY environment variable must always be configured, even if
you are starting the interface from the console.
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Prerequisites
The following are prerequisites for installing the client software:

• installation of the SDM Base software must be completed

• root and maintenance (main) user class access to the SDM must be
established

• cell_admin privileges for the DCE cell, or sdm_admin privileges for the
applications

• DCE account with administrative privileges

• access to FTP on the SDM must be working

• an X Windows-based client machine where the client software is supported

• root user class access to the client machine is present

• access to uncompress and tar on the client machine

Compiling a list of client software filesets

Instructions for batch installation of SDM application software
You must compile a list of software filesets for each application you wish to
install or upgrade. Before beginning the installation procedures, refer to the
user guide of each application for a list of filesets.

ETA fileset descriptions
Before you begin the installation procedure of ETA, you must record the
names of the client filesets. You must refer to this information during the
installation procedures in this chapter.

ETA client software fileset name
Each client program is stored as a .tar.Z file with the following structure:

clientname-version.tar.Z.

where

clientnameis the client name of the application

version is the version number for that client

ATTENTION
Nortel Networks recommends using the batch installation steps in this
section to reduce the amount of time required to install SDM
applications.
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Record the following ETA client software fileset names:

• clientcommon-12.x.x.x.tar.Z

• dcetools.tar.Z

• eta_client-12.x.x.x.tar.Z

Once you have recorded the fileset information, you can, if necessary, refer to
the user guide of other SDM applications for fileset information. If you have
completed the list of filesets for all of the applications you wish to instal,
proceed to the Installing CIL on the client workstation procedure.

Installing CIL on the client workstations
Application

Use this procedure to install the CIL tool on the client workstation.

You must know the following information to perform this procedure:

• the platform and operating system of the client workstations

• the internet protocol (IP) address and root password of the client
workstations

• the root user password of the SDM

• the client software fileset names

Repeat this procedure for every client workstation.

Interval
Perform this procedure when you are installing SDM applications for the first
time.

Common procedures
This procedure refers to the procedure “Installing the client software on the
client workstation” in this chapter.

Action
The flowchart that follows provides a summary of this procedure. Use the
instructions in the step action procedure that follows the flowchart to perform
the routine maintenance procedure.

ATTENTION
Nortel Networks recommends using the batch installation steps in this
section to reduce the amount of time required to install SDM
applications on the client workstations.
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Figure 3-1 Summary of installing CIL on the client workstation

1

2

1

2

Y

N

Login to the
workstation
as the root user

Is CIL for
SDM12 on the

workstation?

Change to
tmp dir

FTP to the
SDM to
download CIL

Retrieve CIL

Quit the FTP
program to
the SDM

Make CIL
executable

Execute CIL

Proceed to the
next procedure to
install the
application

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.



3-6   ETA client software installation and configuration

297-5051-904   Standard   06.01   August 1999

Procedure 3-1 Installing CIL on the client workstation

At the client workstation

1

At the local or remote VT100 console, log in to the client workstation as the
root user.

2 Determine whether the CIL tool for the SDMPL012 release exists on the client
workstation.

3 Change to the temporary directory by typing,

#cd /tmp

and pressing the Enter key.

Note: You can change to any directory if it is a directory where you can
download new files.

4 Open a connection to an SDM which has at least software release
SDMN0012 installed. Open an file transfer protocol (FTP) connection by
typing,

#ftp ip_address

and pressing the Enter key.

where

ip_address
is the IP address of the SDM.

5 Login to the SDM as an anonymous user by typing,

Name: ftp

and pressing the Enter key.

6 When the system asks you for a password, ignore the prompt and press the
Enter key to continue the procedure.

CAUTION
Risk of revealing the administrative user password
If you use telnet to access the client workstation remotely,
and use the default sdm_admin or cell_admin account to
execute the DCE control program (dcecp) commands, the
system sends the administrative user password in clear text
across the network. To prevent this potential security risk,
Nortel Networks recommends that you execute the
commands from a terminal attached to the workstation
console port.

If Do

CIL for SDM12 exists on the client
workstation

step 10

CIL for SDM12 does not exist on
the client workstation

step 3
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7 Retrieve the CIL program by typing,

ftp> get cil

and pressing the Enter key.

8 Quit the connection to the SDM by typing,

ftp> quit

and pressing the Enter key.

9 Make the CIL program executable by typing,

#chmod +x cil

and pressing the Enter key.

10 You have completed this procedure. Proceed to the next procedure “Installing
the client software on the client workstation) to install the software
application” in this chapter.

Installing the client software on the client workstation
Application

Use this procedure to install client software on the client workstation using the
CIL. Make sure that you install CIL on the client workstation before you install
the software application.

Interval
Perform this procedure when you are installing ETA for the first time, or
installing the latest version of ETA on the client workstation.

Common procedures
This procedure does not refer to any common procedures.

Action
The flowchart that follows provides a summary of this procedure. Use the
instructions in the step action procedure that follows the flowchart to perform
the routine maintenance procedure.
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Figure 3-2 Summary of installing the client software on the client workstation
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Procedure 3-2 Installing the client software on the client workstation

At the client workstation

1 Access the tmp directory where the CIL tool exists by typing

#cd /tmp

and pressing the Enter key.

At the local or remote VT100 console

2 Execute CIL by typing,

#./cil

and pressing the Enter key.

Response:

SDM CLIENT SOFTWARE INSTALLATION

Enter the IP address or hostname of the SDM that you want
to download the client software from.

SDM’s Address:

3 At the CIL menu, connect to the SDM by typing

SDM’s Address: sdm_name

and pressing the Enter key.

where

sdm_name
is the IP address or the host name of the SDM.

Response:

SDM CLIENT SOFTWARE INSTALLATION

After you enter ‘Apply’, the selected filesets are FTPed
from the SDM to the /tmp directory. The filesets are then
installed into the /sdm directory. Type ‘Help’ for a list
of commands. Type ‘Quit’ to exit this program.

Client software source: the SDM at bmerye6b
 # Fileset Name

1 ata_client-12.0.12.0.tar.
2 clientcommon-12.0.12.0.tar.Z
3 dcetools-12.0.12.0.tar.Z
4 eta_client-12.0.12.0.tar.Z
5 logreceiver-12.0.12.0.tar.Z

Client Software: 1 to 5 of 5

cil>

4 Select the filesets to install on the client workstation by typing

cil>select n

and pressing the Enter key.

where

n
is the entry number of the fileset on the list.
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Note: To deselect any filesets, select the fileset a second time. To
deselect all filesets, type select none.

5 Install the fileset selected by typing

cil>apply

and pressing the Enter key.

6 You have completed this procedure.

Allowing ETA to operate across a firewall
Special measures must be taken for DCE-based applications to work when the
SDM is separated by a firewall or some other filtering device or from either

• the DCE cell’s security and cell directory servers (CDS)

• a workstation that runs an ETA client program

ETA operates by having the ETA server on the SDM connect back to the ETA
client, in response to a request to establish a session from the client. It is
necessary to control the TCP port that the client uses for the reverse
connection.

Restricting ports for incoming connections works in combination with
firewalls by implementing a packet-filtering technique. Consult the firewall
vendor documentation to determine whether your firewall can be used in this
manner.

Restricting the port range
Use the following procedure to restrict the ETA client reverse connection ports
on the client workstation.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-3 Summary of Restricting the port range
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Procedure 3-3 Restricting the port range

At the local or remote VT100 console

1 Log in to the client workstation as the root user.

2 Change to the ETA directory by typing

#cd /sdm/eta

and pressing the Enter key.

3 Execute the port range configuration script by typing

#./eta_port_range

and pressing the Enter key.

The system displays the following response:

 ENHANCED TERMINAL ACCESS PORT RANGE CONFIGURATION
This configuration script allows you to restrict the ETA
Client reverse connection ports on the client
workstation.
The current port restriction range for the ETA Client is:
Range start: -

Range end:  -
   (no port restriction range)
Set a new port restriction range by typing two numbers
(and pressing [Enter]) which represent the start and end
of the port restriction range. To remove the port
restriction, type ‘None’ and press [Enter]. To quit this
program, type
‘Quit’ and press [Enter].
Port restriction range:

4 At the “Port restriction range:” prompt, type two numerical values
separated by a space:

Port restriction range: a b

and press the Enter key.

where

a
is the start of the range for ports (must be greater than 1024)

b
is the end of the range for ports (must be less than 32 000)

Note 1: These values are not range checked. Verify that these
values range from 1024 to 32 000. Enter the lowest value first.

Note 2: The range size is determined by the maximum number of
simultaneous instances of the ETA client program that are expected to run
on the machine where the client is installed. This is the number of ETA
client instances, not the number of SDM or CM sessions, since all sessions
started by an ETA client instance share the same port number.

5 Exit the program by typing

#quit

and pressing the Enter key.

6 You have completed this procedure.
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Managing ETA extended registry attributes (ERA)
ETA client principal account information is stored on the DCE security server
and managed by the DCE admin user. Users can change the CM password that
belongs to their principal account. You can access one MAP/CI session with
each CM userID and password. To bypass this limitation, an ETA client user
can access a pool of CM user accounts (userIDs and passwords) to establish
multiplex, and simultaneous MAP/CI sessions.

Depending on the user profile, an ETA client user may have one SDM userID
assigned to a principal account. The SDM userID is used to access one or more
SDM sessions. ETA clients may share SDM user accounts with each other
because the SDM has a limited and restricted list of user accounts mainly root
and maint.

The SDM userID, CM userID and CM password information are stored in the
extended registry attributes (ERA) of the DCE principal. The ETA server
queries the information by sending DCE remote procedure calls (RPC) to the
DCE security server. ERA is administered by the DCE administrator user.

Adding ERA values for CM userIDs and passwords
You must set CM userIDs and passwords and add them to a list of ERA values
for each ETA client principal account. When the ETA client requests a
MAP/CI session, the ETA server obtains the client CM userID and password
ERA values, and uses them to log in to the switch for the client. Use the
following procedure to add ERA values for CM userIDs and passwords.

Note: To complete this procedure, you must have already created the ETA
client principal using the create_dce_user command. For information on the
DCE, refer to theSuperNode Data Manager Fault-tolerant User Guide.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-4 Summary of Adding ERA values for CM userIDs and passwords
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Procedure 3-4 Adding ERA values for CM userIDs and passwords

At the client workstation

1 Log into the client workstation.

2 Log into DCE using the administrator userID by typing

>dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
is the administrator userID

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
is the password for the administrator userID

4 Access the bin directory by typing

>cd /sdm/bin

and pressing the Enter key

5 Add the ERA value for the CM userID and password by typing

./add_cm_userid principal_name “CM_userID_list”
“CM_password_list”

and pressing the Enter key.

where

principal_name
is the DCE userID

CM_userID_list
is the CM userIDs

CM_password_list
is all CM passwords (optional)

Note 1: A CM userID can appear more than once.

Note 2: The CM password list is optional. If you do not provide this
information, the add_cm_userid command automatically assigns * for
each password. The password can then be changed through the ETA client
main window. If you provide this information, align each CM userID and
password so that the first password corresponds to the first userID.

Example

./add_cm_userid joe "admin cmap5 cmap8" "a_pwd pwd_5 pwd_8 "

Three CM user accounts are created for the ETA client “joe”. The
password for the admin userID is a_pwd; for the cmap5 userID, pwd_5;
for the cmap8 userID, pwd_8.
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Example

./add_cm_userid joe "admin admin admin" "a_pwd pwd_5 pwd_8”

The CM admin userID has three different passwords (pwd_1, pwd_2 and
pwd_3). Each password is used to access different switches.

6 You have completed this procedure.

Adding ERA values for the SDM userID
You must set an ERA value for the SDM userID of the ETA client using the
add_sdm_userid command. When an ETA client requests an SDM session, the
ETA server obtains the ERA value for the SDM userID of that client, and uses
it to start an SDM session. Use the following procedure to set an ERA value
for an SDM userID.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-5 Summary of Adding an ERA value for an SDM userID
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Procedure 3-5 Adding an ERA value for an SDM userID

At the client workstation

1 Log into the client workstation.

2 Log into DCE using the administrator userID by typing

>dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
is the administrator userID

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
is the password for the administrator userID

4 Access the bin directory by typing

>cd /sdm/bin

and pressing the Enter key

5 Add the ERA value for the SDM userID by typing

./add_sdm_userid principal_name sdm_userid

and pressing the Enter key.

where

principal_name
is the DCE userID you wish to set SDM ERA values for

sdm_userid
is the SDM userID you wish to have

6 You have completed this procedure.

Getting ERA values for CM userIDs
The show_cm_userid command displays an ERA value for CM userIDs. The
information generated assists when the administrator resets the ERA values for
CM userIDs. Use the following procedure to display the ERA values for CM
userIDs.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-6 Summary of Getting ERA values for CM userIDs
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Procedure 3-6 Getting ERA values for CM userIDs

At the client workstation

1 Log in to the client workstation.

2 Log in to DCE using the administrator userID by typing

>dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
is the administrator userID

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
is the password for the administrator userID

4 Access the bin directory by typing

>cd /sdm/bin

and pressing the Enter key.

5 Get the ERA value for the CM userID by typing

./show_cm_userid principal_name

and pressing the Enter key.

where

principal_name
is the CM userID for the CM ERA values you wish to obtain

6 You have completed this procedure.

Getting the ERA value for the SDM userID
The show_sdm_userid command displays the ERA value for the SDM userID.
This information assists the administrator to reset the ERA value for the SDM
userID.

Use the following procedure to display ERA values for SDM userIDs.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-7 Summary of Getting the ERA value for the SDM userID
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Procedure 3-7 Getting the ERA value for the SDM userID

At the client workstation

1 Log into the client workstation.

2 Log into DCE using the administrator userID by typing

>dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
is the administrator userID

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
is the password for the administrator userID

4 Change to the bin directory by typing

>cd /sdm/bin

and pressing the Enter key.

5 Get the ERA value for the SDM userID and password by typing

./show_sdm_userid principal_name

and pressing the Enter key.

where

principal_name
is the SDM userID for the SDM ERA value you wish to obtain.

6 You have completed this procedure.

Removing ERA values for CM userIDs and passwords
The remove_cm_userid command removes ERA values for CM userIDs and
passwords. Use the following procedure to remove ERA values for CM
userIDs and passwords.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-8 Summary of Removing ERA values for CM userIDs and passwords
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Procedure 3-8 Removing ERA values for CM userIDs and passwords

At the client workstation

1 Log into the client workstation.

2 Log into DCE using the administrator userID by typing

>dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
is the administrator userID

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
is the password for the administrator userID

4 Access the bin directory by typing

>cd /sdm/bin

and pressing the Enter key.

5 Remove the ERA value for the CM userID and password by typing

./remove_cm_userid principal_name

and pressing the Enter key.

where

principal_name
is the CM userID for the ERA value you are removing

6 You have completed this procedure.

Removing the ERA value for the SDM userID
The remove_sdm_userid command removes the ERA value for the SDM
userID.

Use the following procedure to remove the ERA value for the SDM userID.

The following flowchart summarizes the procedure. Use the instructions in the
step-action procedure that follows the flowchart to perform the task.
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Figure 3-9 Summary of Removing the ERA value for the SDM userID

Log in to the
client work-
station

Enter the DCE
password

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

End

Log in to DCE
using admin
userID

Access the
bin directory

Remove the
value for the
SDM userID



3-26   ETA client software installation and configuration

297-5051-904   Standard   06.01   August 1999

Procedure 3-9 Removing the ERA value for the SDM userID

At the client workstation

1 Log into the client workstation.

2 Log into DCE using the administrator userID by typing

>dce_login DCE_admin_user

and pressing the Enter key.

where

DCE_admin_user
is the administrator userID

3 Enter your DCE password by typing

>password

and pressing the Enter key.

where

password
is the password for the administrator userID

4 Access the bin directory by typing

>cd /sdm/bin

and pressing the Enter key.

5 Remove the ERA value for the SDM userID by typing

./remove_sdm_userid principal_name

and pressing the Enter key.

where

principal_name
is the DCE userID for the SDM ERA value you are removing

6 You have completed this procedure.
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4  ETA graphical user interface (GUI)

This chapter describes how to use the ETA GUI under the following headings:

• selecting menu items

• using the pull-down menus on the ETA main window

• using the pull-down menus on the SDM and CI/MAP windows

• using and adjusting ETA session windows

• copying and pasting text

• interpreting status icons

• using the on-line help utility

• interpreting information and error messages

Selecting menu items
How you navigate using the GUI to select menu items differs depending on
your workstation. Use the following guide to select a menu item:

• If you are using a SUN workstation, press the right mouse button.

• If you are using a Hewlett-Packard workstation, press the left mouse
button.

Note: These instructions may vary depending on how you have configured
your mouse button.

Using pull-down menus on the ETA main window
Figure 4-1 shows the features of the ETA main window.
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Figure 4-1 ETA main window

This section describes the function of the pull-down menus on the ETA main
window. There are four pull-down menus on the window:

• File

• Action

• Options

• Help
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File pull-down menu
The File pull-down menu has one submenu: Exit. Use this option to exit the
ETA application. Figure 4-2 shows the File pull-down menu.

Figure 4-2 File pull-down menu

Action pull-down menu
The Action pull-down menu has the following submenus:

• Change CI/MAP Password

Use this option to change your computing module (CM) password in the
Distributed Computing Environment (DCE) database.

• Access SDM
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Use this option to access the SDM of the DMS-100 switch that you have
selected from the Switch names list.

• Access CI/MAP

Use this option to access the CI/MAP of the DMS switch that you have
selected from the Switch names list.

Figure 4-3 shows the Action pull-down menu.

Figure 4-3 The Action pull-down menu
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Options pull-down menu
The Options pull-down menu has the following submenus:

• Wrap lines to fit

Use this option in any ETA window to change the appearance of the lines
displayed on your screen. If you select the Wrap lines to fit option, all
content appears in the window viewing area.

Note: If you do not select the Wrap lines to fit option, you cannot read
the text that runs beyond the window frame.

If you select the Wrap lines to fit option, the check box is inverted
(darkened). You can select or deselect this option by clicking on the check
box. The default setting is “on” (selected).

• Font sizes

Use this option in any ETA window to change the size of the font displayed
on your screen.You can choose from the following five sizes:

— Tiny (3.6-point font)

— Small (8-point font)

— Medium (12-point font)

— Large (14-point font)

— Huge (18-point font)

The default setting is Large.

Figure 4-4 shows the Options pull-down menu.
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Figure 4-4 Options pull-down menu

Help pull-down menu
The Help pull-down menu at the rightmost end of the menu bar has the
following submenus:

• On Context...

Use this option to obtain context-sensitive help. You can obtain
information on a specific topic by clicking on the appropriate area of the
window.

• On Help...

Use this option to learn more about how to use the on-line help utility.

• About ETA...

Use this option to view the Nortel copyright information, and the version
number of the ETA software.

Note: For additional information on the Help menu, refer to the section
titled “Using the on-line help utitlity”..
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Figure 4-5 shows the Help pull-down menu.

Figure 4-5 Help pull-down menu

Using the pull-down menus on the SDM and CI/MAP windows
This section describes the function of the pull-down menus on the SDM and
CI/MAP windows. There are two pull-down menus on these windows:

• File

• Options

Note: The figures that follow show the menus on the SDM session window.
The menus function in the same manner for both the SDM and CI/MAP
window.

Figure 4-6 shows the SDM session window.
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Figure 4-6 SDM session window

File pull-down menu on the SDM and CI/MAP windows
The File pull-down menu has the following submenus:

• Start logging to file ...

Use this option to save the output of a session to a new or existing ASCII
file.

• Stop logging to file

Use this option to stop the output of a session to an ASCII file.

• Save current view ...

Use this option to save the current view of the remote maintenance
interface (RMI) or maintenance and administration position (MAP) to a
new or existing ASCII file.

• Close

Use this option to close the current ETA window.

Figure 4-7 shows the File pull-down menu on the SDM window.

File

ottwaonye6a - SDM Session

Options

There are no other users logged on to the SDM.
There are no users logged on to the SDM Maintenance Menu System.

Current SDM status:
SDM CON LAN APPLSYS HW
 I  .  S  I  .  .

#
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Figure 4-7 File pull-down menu on the SDM session window

Using and adjusting ETA session windows
This section describes how to use and adjust the ETA session windows.

Using multiple windows
You can have several windows open in one ETA session. Each window is
identified by a title at the top of the window that records the session name and
the CLLI name.

The system cascades the windows to allow you to switch your window view.
To activate a different window view, click anywhere in the desired window.

To see a list of titles of open windows, move your cursor to any window. Click
and hold the middle mouse button. If you wish to change from one window to
another while viewing the list, drag the pointer down the list. The system
highlights each item as you move the pointer through the list. When you have
highlighted the title of the window you wish to view, release the middle mouse
button. The system displays the window you have selected.
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1 Table Access Service 9.0.21.0    InSv
2 OM Access Service 9.0.21.0    InSv
3 Log Delivery Service 9.0.21.0    InSv
4 Exception Reporting 9.0.21.0    InSv
5 Enhanced Terminal Access 9.0.21.0    InSv
6 Secure File Transfer 9.0.21.0    InSv

Stop logging to file

Close

Start logging to file ...

Save current view ...
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Moving an ETA session window
You can move any window to another location on your screen. Click with the
left mouse button on the title bar at the top of any window frame. Hold the
button down while you drag the window to a new location on your screen.

Adjusting the size of an ETA session window
You can also adjust the size of any window. Move your cursor to the frame of
a window. (The cursor changes shape to indicate that you can modify the size
of the window.) Click with the left mouse button on the frame. Hold the button
down while you drag your cursor to adjust the size of the window. Release the
left mouse button when the window reaches the size you wish.

Note: The maximum number of characters displayed on each line depends
on the size of your monitor and the font size that you have selected.

You must perform the following command at the UNIX prompt if you intend
to do a vi operation after adjusting the window size:

>EVAL ‘RESIZE’

and press the Enter key.

Copying and pasting text
You can copy and paste text in the ETA session window. To copy, use the left
mouse button to click and drag over the text. To paste, move you cursor to the
desired location and press the right mouse button.

Interpreting status icons
The following status icons indicate there are either operations in progress, or
existing connectivity problems.

Operation-in-progress icon
The operation-in-progress icon indicates a pending request from the client to
the SDM. This icon normally appears only briefly when changes are applied.

Loss-of-connection icon
The loss-of-connection icon indicates that your workstation cannot connect to
the SDM for the switch.
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Using the on-line help utility
Use the help utility to obtain information on ETA features or on the help utility
itself. To access on-line help, click on Help in the menu bar.

For context-sensitive help, select “On Context....”. When you select this
option, the cursor changes to a large question mark (?). Move the question
mark to any area in the window for which you want information, and click on
that area.

Figure 4-8 shows the On-Line Help window.

Figure 4-8 Example of On-Line Help window

Use the scroll bar to navigate through the help text. In addition, the help
window provides a list of hyper-linked terms listed under “See also”. To get
information about any of these terms, move your pointer to the item you wish
to investigate. When your arrow pointer changes to a hand pointer, click on it
with your left mouse button. The help window for that item appears.

When you finish using help, you can leave the help window open and return to
your ETA window. To close the help window, select Exit from the File menu
in the help window.

For additional information about the help utility, select “On Help...” from the
Help menu.

On Line Help

 Switch Names
This list contains a Common Language Location
Identifier (CLLI) of all the switches in the DCE cell. This list
is obtained automatically from the central DCE Directory
(CDS) server when ETA is started.
Select a switch on which to start a terminal session by
clicking on it with the left mouse button. To deselect a
switch, click on it again with the left mouse button.

See also:
Find Switch Name
Switch Icons
Enhanced Terminal Access

File



4-12   ETA graphical user interface (GUI)

297-5051-904   Standard   06.01   August 1999

Interpreting information and error messages
The ETA GUI displays two types of cautionary message boxes to alert you to
the state of the ETA application: information message boxes and error message
boxes.

Information message boxes are indicated by a large “i” to the left of the text.
The boxes provide information on the potential impact of an action you are
about to perform.

Figure 4-9 shows example of an information box.

Figure 4-9 Sample information message box

Error message boxes are indicated by a large “!” to the left of the text. These
boxes report errors that can occur during the operation of ETA. For a detailed
list of error messages and suggested actions to resolve such errors, see the
“Appendix: ETA error messages” in this document.

Figure 4-10 shows an example of an error message box.

Figure 4-10 Sample error message box

This operation will only change your MAP/CI
password in the central database. Make sure you
have the same password for the userid on the
DMS.

OK

i

Password validation failed.

DCE message text: << Registry object not found
(dce / sec) >>

OK
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5  Using ETA

This chapter describes the following:

• starting the ETA client application

• establishing a SuperNode Data Manager (SDM) session

• establishing a CI/MAP session

• logging an SDM or CI/MAP session to an output file

• saving the current RMI or MAP display view

• changing computing module (CM) passwords in the Distributed
Computing Environment (DCE) security database and on the DMS-100
switch

You must have a DCE principal name (userID) and password to use ETA. If
you do not have a DCE account, your DCE administrator can create one for
you.

Note 1: DCE procedures are described in theDMS-100 Family SuperNode
Data Manager Fault-tolerant User Guide, 297-5051-906.

Note 2: You must make sure that you use a DCE principal name updated
with software from the SDMN0009.3 load or later. Doing so eliminates
compatibility problems for systems running SDM and client ETA software
from either or both of the SDMN0008 and SDMN0009 software releases.
For information on how to update DCE principal names, refer to the
DMS-100 Family SuperNode Data Manager Fault-tolerant User
Guide,297-5051-906.

Starting the ETA client application
Use the following procedure to start the ETA client application. Depending on
your workstation configuration, you might be automatically logged into DCE
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when you log in. If this is not the case, you are prompted for your DCE
principal name and password when you start the ETA client application.

The following flowchart summarizes the procedures for starting the ETA client
application.

ATTENTION
Do not use Network Information Service (NIS). The SDM does not
support NIS.

ATTENTION
The following condition can occur if the defined port_range on a client
workstation is small and you initiate multiple ETA application sessions.
If all available ports are in use, the next session displays an error dialog
box that indicates that no ports are available. The session terminates and
writes errors to the core file. Refer to the core file to diagnose the
problem.

ATTENTION
If you use the ETA SDM session window to manually busy (ManB) the
ETA server or the SDM, the session window becomes inoperative. To
close the window, click on the top left corner of the window frame and
select the close option from the pull-down menu.
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Figure 5-1 Summary of starting the ETA client application
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Procedure 5-1 Starting the ETA client application

At the client workstation:

1 Log into the client workstation as any user other than root.

Note: If you log in to the client workstation as the root user, type
dce_login, followed by your DCE login ID. At the password prompt, enter
your password.

2 Change to the bin directory by typing

>cd /sdm/bin

and pressing the Enter key.

3 Start the ETA application by typing

>./eta

and pressing the Enter key.

Note: If you are logged in as the root user, you do not see the copyright
window or the DCE Login window. The Enhanced Terminal Access window
appears (see step 5).

The system displays the copyright window.

Note: The copyright window disappears automatically after 10 s.

4 Wait 10 s. The DCE Login window appears.

Nortel Copyright Information

(C) Copyright 1997-1998 by Northern Telecom Ltd.
All Rights Reserved.

SDM Enhanced Terminal Access (ETA)
Version 10.0.12.0
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5 Enter your DCE userID in the principal name field of the DCE Login window.

Use the Tab key to move to the password field.

Enter your DCE password, and press the Enter key or the “OK” button.

Note: If you do not wish to login, you can click on Abort. The system
returns to the UNIX prompt. The system displays the Enhanced Terinal
Access window when you have successfully logged into the DCE.

The ETA main window appears.

DCE Login

Principal name:

Password:

OK Abort
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6 You have completed this procedure.

Error messages after logging in
The following graphic is an example of an error message that appears if you
use an incorrect DCE password. Select OK to continue.

Enhanced Terminal Access
File Action     Options

Switch Names

Access CI/MAP

OTWAON10FCC

ECCOMB_SDM

FCC1
FCC11

FCC1_0

FCC2
ottwaonxx01
ottwaonye68

ottwaonye69
ottwaonxx01
ottwaonye68
ottwaonye69
ottwaonye69

Access SDM

Help

Find switch name:
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Note: If an error window containing a TraceBack button appears, this
indicates a potentially serious software error. Have your system
administrator click on TraceBack and record the data provided in the system
response for analysis purposes, then click on OK to continue. If required,
contact Nortel Networks for assistance. For information about Traceback,
refer to your Traceback User Guides.

Establishing an SDM session
Use this procedure to establish an SDM session after you have successfully
logged in to DCE.

You must have a DCE account and an SDM userID (root or maint) to establish
an SDM session. The SDM userID is part of your SDM profile, which includes
the SDM userID and SDM program access information.

Copy and paste functionality is available from the SDM session window. To
copy, use the left mouse button to click and drag over the text. To paste, use the
right mouse button.

The following flowchart summarizes the procedure for establishing an SDM
session.

Password validation failed.

DCE message text: << Registry object not found
(dce / sec) >>

OK
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Figure 5-2 Summary of establishing an SDM session

Find the
switch name

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

End

Select
Access SDM
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Procedure 5-2 Establishing an SDM session

In the ETA main window:

1 Use one of the following methods to find and select the switch name you wish
to access.

2 Type the name of the switch in the Find switch name dialog box and press the
Enter key.

The system highlights the name of the switch or the name of the switch that
closest resembles what you have typed

To deselect a switch name, click on the switch name a second time.

Go to step 4.

If Do

you know the full or partial switch
name

step 2

you do not know the switch name step 3

Enhanced Terminal Access
File Action     Options

Switch Names

Access CI/MAP

OTWAON10FCC

ECCOMB_SDM

FCC1
FCC11

FCC1_0

ottwaonxx01
ottwaonye68

ottwaonye69
ottwaonxx01
ottwaonye68
ottwaonye69
ottwaonye69

Help

Find switch name:

FCC2

FCC2

Access SDM
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3 Scroll through the list and click on the name of the switch that you wish to
access.

4 Select Access SDM.

Note: Your SDM user profile determines the type of session window that
appears. You see a UNIX shell or you are placed directly into the SDM
program to which you have access.

Example SDM Session screen.

Note 1: For more information on maint user commands, refer to the
SuperNode Data Manager Fault-tolerant User Guide, 297-5051-906.

Note 2: To end an SDM session, Nortel recommends that you type “exit”.
You may also use the Close button located at the top left-hand side of the
screen to close the session window.

5 You have completed this procedure.

Error message when establishing an SDM session
The following graphic is an example of an error message that appears if the
system is unable to communicate with the switch you have selected. Select OK
to continue.

File

FCC2 - SDM Session

Options

There are no other users logged on to the SDM.
There are no users logged on to the SDM Maintenance Menu System.

Current SDM status:
SDM CON LAN APPLSYS HW
 I  .  S  I  .  .

#
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Establishing a CI/MAP session
Use this procedure to establish a CI/MAP session after you have successfully
logged in to DCE.

You must have a DCE account and a CM switch userID and password to
establish a CI/MAP session.

Copy and paste functionality is available from the CI/MAP session window.
To copy, use the left mouse button to click and drag over the text. To paste, use
the right mouse button.

The following flowchart summarizes the procedure for establishing a CI/MAP
session.

Error while attempting to communicate with FCC1.
The server is not in service on the SDM.

OK
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Figure 5-3 Summary of establishing a CI/MAP session

Find the
switch name

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

End

Click the
Access
CI/MAP button
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Procedure 5-3 Establishing a CI/MAP session

In the ETA main window:

1 Highlight the DMS switch name you wish to access.

Example screen.

Note: To deselect a DMS switch name, click on the switch name a second
time.

2 Click “Access CI/MAP”.

The CI/MAP Session window appears.

Enhanced Terminal Access
File Action     Options

Switch Names

OTWAON10FCC

ECCOMB_SDM

FCC1
FCC11

FCC1_0

ottwaonxx01
ottwaonye68

ottwaonye69
ottwaonxx01
ottwaonye68
ottwaonye69
ottwaonye69

Help

Find switch name:

FCC2

FCC2

Access SDM Access CI/MAP
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Note: To end a CI/MAP session, Nortel Networks recommends that you
type “logout”. You may also use the Close button located at the top
left-hand side of the screen to close the session window.

3 You have completed this procedure.

Logging an SDM or CI/MAP session to an output file
Use this procedure to log an SDM or CI/MAP session to an ASCII output file.

The following flowchart summarizes the procedure for logging an SDM or
CI/MAP session to an output file.

File

FCC2 - CI/MAP Session

Options

CMAP4 Logged in on 1997/04/17 at 13:22:55

*********************************************************************
**   **
** This is a private database.   **
** All activity is subject to monitoring.   **
** Any UNAUTHORIZED access or use is PROHIBITED, and   **
** may result in PROSECUTION.   **
**   **
*********************************************************************

1997/04/10 23:50 rcna07bq bfcc2
>
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Figure 5-4 Summary of logging an SDM or CI/MAP session to an output file

Select start
logging to file

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

Close the
ETA session

Save file
name

Stop logging

End

Establish an
ETA session
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Procedure 5-4 Logging the SDM or C/I MAP session to an output file

1 Establish an SDM or CI/MAP session. Refer to the procedures “Establishing
an SDM session”, and “Establishing a CI/MAP session”.

Example response.

2 From the File menu in the SDM or CI/MAP Session window, select the Start
logging to file... menu item.

The Set a log filename dialog appears.

File

ottwaonye6a - SDM Session

Options

2
 3
 4 Logs
 5
 6
 7 Bsy
 8 RTS
 9 OffL
10
11
12
13
14 QuerySDM
15 Locate
16
17 Help
18 Refresh
   root
Time  16:22  >

 SDM Remote Maintenance Interface
    ON     LAN     APPL     SYS     HW         CM : FCC2

. . . . . SDM: bmerye78

State: InSv
3DM Application State: InSv

# Package Description Version    State
1 Table Access Service 9.0.21.0    InSv
2 OM Access Service 9.0.21.0    InSv
3 Log Delivery Service 9.0.21.0    InSv
4 Exception Reporting 9.0.21.0    InSv
5 Enhanced Terminal Access 9.0.21.0    InSv
6 Secure File Transfer 9.0.21.0    InSv

Stop logging to file

Close

Start logging to file ...

Save current view ...
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Note: You are prompted for the file name. Nortel Networks recommends
that you accept the default file name in the current directory. (Delete the
files in the current directory that are no longer required. An error can occur
if you do not have read and write permission in the specified directory.)

If Do

you want to select the
default file name

step 3

you want to select an
existing file name in the
current directory

step 4

you want to specify a new file name step 5

Set a log file name

/bnr/users/guest/tmp/ETAlog.*

Filter

Directories

..

.netscape

Files

ETAlog.12021448

ETAlog.12021503

ETAlog.12021523

ETAlog.12031226

ETAlog.new

/bnr/users/guest/tmp/ETAlog.12040849

Selection

OK Filter Cancel

Set a log file name

/bnr/users/guest/tmp/ETAlog.*

Filter

Directories

..

.netscape

Files

ETAlog.12021448

ETAlog.12021503

ETAlog.12021523

ETAlog.12031226

ETAlog.new

/bnr/users/guest/tmp/ETAlog.12040849

Selection

OK Filter Cancel
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3 Select the default file name by clicking on OK. A message appears in the
status area at the bottom of the SDM Session window. The message
indicates that the output is being logged to a file.

Note: The default file name appears under the Selection heading in the
Set a log file name window. The default file name format is
ETAlog.mmddhhmm, where mmddhhmm is the current month, day, hour,
and minute.

In the example in step 2, Logging to file
/bnr/users/guest/tmp/ETAlog.12040849 indicates that /bnr/users/guest/tmp is
the directory where the file is located, ETAlog is the file prefix, and 12040849
is the file extension. The file extension indicates that the file was opened on
December 4 (1204), at 8:49 a.m. (0849).

Go to step 6.

4 Select an existing file name by clicking on a file name displayed under the
Files heading in the Set a log file name window. Click on OK.

Note: If you choose an existing file name, the new session output is
appended to the existing file.

Go to step 6.

5 Type a new file name in the Selection heading area of the Set a log file name
window. Position the cursor on the default file name extension mmddhhhmm
and backspace to erase.

6 Determine if you want to save a current view of the RMI or MAP display while
you are logging an SDM session to an output file.

Note: The Logging an SDM session to an output file procedure does not
save the RMI and the MAP display view.

7 Select the Save current view... menu item from the File menu in the SDM
Session window.

The Set a text file name window appears.

If Do

you want to save a
view of the RMI or MAP display

step 7

you do not want to save
a current view of the RMI
or MAP display

step 9
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8 Select the default file name in the current directory by clicking on OK.

Note: You can append different snapshots of the RMI or MAP display view
to the same file by reusing the same file name.

9 Stop logging the file by selecting the Stop logging to file... menu item from the
File menu in the SDM Session window.

Note: You cannot start logging another file session until you stop the
current logging session.

10 Close the current ETA session window.

11 Exit the SDM session by typing

>exit

12 Exit the CI/MAP session by typing

If Do

you are in a SDM session step 11

you are in a CI/MAP
session

step 12

Set a text file name

/bnr/users/guest/tmp/ETAmap.*

Filter

Directories

..

.netscape

Files

ETAmap.12021545

ETAmap.12031031

/bnr/users/guest/tmp/ETAmap.12040919

Selection

OK Filter Cancel
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>logout

13 You have completed this procedure.

Saving the current RMI or MAP display view
Use the following procedure to save an RMI or MAP display view to a text file.

The following flowchart summarizes the procedure for saving an RMI or MAP
display view to a text file.
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Figure 5-5 Summary of saving the current RMI or MAP display view

Select Save
current view

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

Close the
ETA session

Save file name

End

Establish an
ETA session
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Procedure 5-5 Saving the current RMI or MAP display view

1 Establish an SDM or CI/MAP session. Refer to Procedures “Establishing an
SDM session”, and “Establishing a CI/MAP session”..

Example response.

2 From the File menu in the SDM or CI/MAP Session window, select the Save
current view... menu item.

The Set a text file name window appears.

File

ottwaonye6a - SDM Session

Options

2
 3
 4 Logs
 5
 6
 7 Bsy
 8 RTS
 9 OffL
10
11
12
13
14 QuerySDM
15 Locate
16
17 Help
18 Refresh
   root
Time  16:22  >

 SDM Remote Maintenance Interface
    ON     LAN     APPL     SYS     HW         CM : FCC2

. . . . . SDM: bmerye78

State: InSv
3DM Application State: InSv

# Package Description Version    State
1 Table Access Service 9.0.21.0    InSv
2 OM Access Service 9.0.21.0    InSv
3 Log Delivery Service 9.0.21.0    InSv
4 Exception Reporting 9.0.21.0    InSv
5 Enhanced Terminal Access 9.0.21.0    InSv
6 Secure File Transfer 9.0.21.0    InSv

Stop logging to file

Close

Start logging to file ...

Save current view ...
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Note: When you select a name for the RMI or MAP display view file, you
are prompted for the file name. Nortel Networks recommends that you
accept the default file name in the current directory. In the example in step
2, the default file name is 12021545. Delete the files in the current directory
that are no longer required. An error can occur if you do not have read and
write permission in the specified directory.

3 Select the default file name by clicking on OK.

If Do

you want to select the
default file name

step 3

you want to select an
existing file name in the
current directory

step 4

you want to specify a new file name step 5

Set a text file name

/bnr/users/guest/tmp/ETAmap.*

Filter

Directories

..

.netscape

Files

ETAmap.12021545

ETAmap.12031031

/bnr/users/guest/tmp/ETAmap.12040919

Selection

OK Filter Cancel
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The default file appears under the Selection heading in the Set a text file
name window. The default file name format is ETAlog.mmddhhmm, where
mmddhhmm is the current month, day, hour, and minute.

Note: In the example in step 2, Logging to file
/bnr/users/guest/tmp/ETAlog.12040919 indicates that users/guest is the
directory where the file is located, ETAlog is the file prefix, and 12040919
is the file extension. The file extension indicates that the file was opened
on December 4 (1204), at 9:19 a.m. (0919).

Go to step 6.

4 Select an existing file name by clicking on a file name displayed under the
Files heading. Click on OK.

Note: You can append different snapshots of the RMI or MAP display view
to the same file by reusing the same file name.

Go to step 6.

5 Type a new file name in the Selection heading area of the Set a text file name
window. Position the cursor on the default file name extension mmddhhhmm
and backspace to erase.

Go to step 6.

6 Close the current ETA session window.

7 Exit the CI/MAP session by typing

>logout

8 Exit the SDM session by typing

>exit

9 You have completed this procedure.

Changing CM passwords
Changes to CM passwords must be made in the DCE security database, and on
the DMS-100 switch. ETA clients can change their own user passwords at the
ETA main window.

Note: The CM password must be manually changed on the DMS switch
before or immediately after the CM password has been changed in the DCE
security database.

Changing CM passwords in the DCE security database
Use the following procedure to change your CM password in the DCE security
database. Make sure that you change your CM password on the DMS-100
switch before or immediately after you have completed this procedure.

If Do

you are in a SDM session step 7

you are in a CI/MAP
session

step 8
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The following flowchart summarizes the procedure for changing your CM
password in the DCE security database.
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Figure 5-6 Summary of Changing CM passwords in the DCE security database

Select the
password
change
option

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

Highlight the
CM userID

Click on OK
to continue

End

Enter the old
and the new
password

Change
another

password?

Y

N

1

1
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Procedure 5-6 Changing CM passwords in the DCE security database

At the ETA main window

1 Select Change CI/MAP Password from the Action pulldown menu.

The ETA Userid Info window appears.

2 Highlight the CM userID for which you wish to change the password.

Enhanced Terminal Access

Switch Names

OTWAON10FCC

FCC11

FCC1_0

ottwaonxx01
ottwaonye68

ottwaonye69
ottwaonxx01
ottwaonye68
ottwaonye69
ottwaonye69

Access SDM

ECCOMB_SDM

FCC1

FCC2

Access CI/MAP

File Action

Change CI/MAP Password

Access SDM

Access CI/MAP
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3 Click on Change password.

A warning message appears.

4 You must manually make the password change on the DMS-100 switch
immediately after or before you change your CM password in the DCE
security database.

SDM Userid    maint

Done

cmap9

Change password

MAP/CI Userids

ETA Userid Info

admin
admin
ap10

cmap8

This operation will only change your MAP/CI
password in the central database. Make sure you
have the same password for the userid on the
DMS.

OK

i
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Click on OK to continue.

Note: The two admin userids are used to access different DMS-100
switches. This allows multiple passwords to be used with each CM userID.

The Change CM Password window appears.

5 Enter the old password, the new password, and re-enter the new password.
Click on OK when you are finished.

The Change CM Password window disappears after you click on Ok.

6 Determine whether you wish to change another DMS-100 switch password.

7 Click on Done from the ETA User Info window.

If Do

you are changing another
password

step 1

you are finished changing
passwords

step 7

MAP/CI Userid:    admin

Enter old password:

Enter new password:

Re-enter new password:

CancelOK

Change CM Password
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8 You have completed this procedure.

Changing the CM password on the DMS-100 switch
Use the following procedure to change your CM password. You must complete
this procedure before or immediately after you change your CM password in
the DCE security database.

Note: Under certain conditions, the CM response from a user-entered
command and subsequent user keyboard input compete for the display
cursor. The CM output and the user input may be interleaved causing
“garbled” data to appear. This limitation also exists on the telnet sessions off
an Ethernet Interface Unit (EIU). To correct this problem refresh the screen.
This limitation does not corrupt data or user commands on the CM.

The following flowchart summarizes the procedure for changing the CM
password in the DMS-100 switch.

SDM Userid    maint

Done

admin
cmap10

cmap8

cmap9

Change password

MAP/CI Userids

ETA Userid Info

admin



Using ETA 5-31

DMS-100 Family SuperNode Data Manager Enhanced Terminal Access User Guide

Figure 5-7 Summary of Changing the CM passwords on the DMS-100 switch

Find the
switch name

This flowchart summarizes the
procedure.

Use the instructions that follow
this flowchart to perform the
procedure.

Select Access
CI/MAP

Change the
password

End

Verify the new
password
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Procedure 5-7 Changing the CM passwords on the DMS-100 switch

At the ETA main window:

1 Select the DMS-100 switch name.

2  Click on Access CI/MAP.

A CI/MAP session window appears.

Enhanced Terminal Access
File Action     Options

Switch Names

OTWAON10FCC

ECCOMB_SDM

FCC1
FCC11

FCC1_0

ottwaonxx01
ottwaonye68

ottwaonye69
ottwaonxx01
ottwaonye68
ottwaonye69
ottwaonye69

Help

Find switch name:

FCC2

FCC2

Access SDM Access CI/MAP
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3 Change the CM password on the DMS-100 switch by typing

>password

and pressing the Enter key.

4 At the password prompt, type

Password: password

and press the Enter key.

where

password  is your new password

The following message appears:

Please enter new password again to verify.

5 Verify your new password by typing

>password

and pressing the Enter key.

where

password  is the new password

The following message appears:

Enter your current password to verify.

File

FCC1 - CI/MAP Session

Options

CMAP4 Logged in on 1997/04/17 at 13:22:55

*********************************************************************
**   **
** This is a private database.   **
** All activity is subject to monitoring.   **
** Any UNAUTHORIZED access or use is PROHIBITED, and   **
** may result in PROSECUTION.   **
**   **
*********************************************************************

1997/04/10 23:50 rcna07bq bfcc2
>
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6 Enter your old password by typing

>password

and pressing the Enter key.

where

password  is the your old password

A message informs you that the password has been successfully changed,
and that it must be changed in 30 d.

7 You have completed this procedure.
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A-1

Appendix A  ETA status and error
messages

This chapter describes ETA status and error messages.

ETA status messages
This section describes the ETA status messages and what actions you must
follow to resolve a trouble message.

The state of the ETA application appears as InSv (in-service) during operation.
If the state is ISTb (in–service trouble), the ETA server is in service trouble. If
the ISTb state persists for ETA for more than 10 min, it may be necessary to
busy (ManB) and return to service (RTS) the ETA application.

Note: To busy an application, you must access the application (Appl) menu
level of the SDM remote maintenance interface (RMI). For more
information, refer to theDMS-100 Family SuperNode Data Manager
Fault-tolerant User Guide.

If the application fails to go in-service (InSv) 10 min after you manually busy
it and return it to service, contact your next level of support.

ETA error messages
This section lists and describes the ETA error messages, what each error
message means, and what actions you must follow to resolve the errors.

Table A-1 lists the following:

• each ETA error message (in alphabetical order)

• the conditions under which the system generates each message

• the suggested actions to resolve the problem associated with each message
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You can fix some errors by performing the actions noted in the following table.
Other errors require the help of your system administrator. If the suggested
action does not fix the error, contact your system administrator.

Table A-1 Error messages (Sheet 1 of 3)

Error message Conditions Suggested action

Incompatibility between client and
SDM server.

Invalid option. Contact your system
administrator.

Invalid option. Contact your system
administrator.

Server experienced a connection
failure.

This could be caused by a SDM or
client workstation resource shortage.

Try later, or contact your system
administrator.

SDM or client workstation
resource shortage.

Try again later.

Server experienced a system failure.

This could be caused by an SDM
resource shortage.

Try later, or contact your system
administrator.

SDM resource shortage. Try again later.

Unable to initiate the CI/MAP session.

The CI/MAP password stored in the
security database does not match the
one on the switch.

Either change the password in the
database, or on the switch, or contact
your system administrator.

CI/MAP password stored in
the security database does
not match the one on the
DMS-100 switch.

Change the password in
the database or on the
DMS-100 switch and verify
they are the same.

Unable to initiate the CI/MAP session.

The number of CI/MAP sessions has
reached the limit.

Please try it later.

The number of CI/MAP
sessions has reached the
limit.

Try again later.

Unable to initiate the CI/MAP session.

There is a mismatch between the
number of CI/MAP userids and
corresponding passwords in the
security database.

Contact your system administrator.

Mismatch on the security
server. The number of
CI/MAP userids does not
match the number of CI/MAP
passwords.

Contact your system
administrator.
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Unable to initiate the CI/MAP session.

Your CI/MAP user name or password
might be invalid on the switch. Or all
your CI/MAP user accounts are
currently being used.

Contact your system administrator.

Invalid CI/MAP username or
password.

or

All your CI/MAP user
accounts are currently being
used.

Contact your system
administrator.

Unable to initiate the CI/MAP session.

Your CI/MAP userid does not exist on
the switch.

Contact your system administrator.

CI/MAP userid failure. Contact your system
administrator.

Unable to initiate the SDM session.

The number of SDM sessions has
reached the limit.

Please try later.

The number of SDM sessions
has reached the limit.

Try again later.

Unable to initiate the SDM session.

Your SDM userid does not exist on the
SDM.

Contact your system administrator.

SDM userid failure. Contact your system
administrator.

Unable to update password in the
security database.

Server failed to read CI/MAP userids.

Contact your system administrator.

Server failed to read CI/MAP
userids.

Contact your system
administrator.

Unable to update the CI/MAP
password in the security database.

Server does not have write permission
to your cm_passwd attribute.

Contact your system administrator.

Server does not have write
permission to your
cm_passwd attribute.

Contact your system
administrator.

Unable to update the CI/MAP
password in the security database.

Server failed to find your CI/MAP
userid.

Contact your system administrator.

CI/MAP userid failure. Contact your system
administrator.

Table A-1 Error messages (Sheet 2 of 3)

Error message Conditions Suggested action
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Unable to update the CI/MAP
password in the security database.

Server failed to read the CI/MAP
password.

Contact your system administrator.

Server failed to read the
CI/MAP password.

Contact your system
administrator.

Unable to update the CI/MAP
password in the security database.

The number of CI/MAP userids and
passwords are mismatched.

Contact your system administrator.

Mismatch between the
number of CI/MAP userids
and passwords.

Contact your system
administrator.

Unable to update the CI/MAP
password in the security database.

The old password is wrong.

Update password failure. Contact your system
administrator.

You are not authenticated.

Check if your DCE login has expired,
or if your client was started with the

-serverless option, or contact your
system administrator.

DCE login has expired. Contact your system
administrator.

You have too many CI/MAP userid
entries in your security database.

Contact your system administrator.

The number of CI/MAP userid
entries in your security
database has exceeded the
limit.

Contact your system
administrator.

Your client program’s security level is
insuficient.

Check if your client was started with
the -no_privacy option,or contact your
system administrator.

Client program lacks proper
security clearance.

Check whether your client
was started with the

-no_privacy option
selected..

Your DCE principal does not have an
associated CI/MAP userid or
password.

Your DCE principal does not
have an associated CI/MAP
userid or password.

Contact your system
administrator.

Your DCE principal does not have an
associated SDM userid.

Your DCE principal does not
have an associated SDM
userid.

Contact your system
administrator.

Table A-1 Error messages (Sheet 3 of 3)

Error message Conditions Suggested action
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